Developing Enterprise Risk Management Framework/Facilitating Enterprise Wide Risk Assessment

A Consultancy Report Submitted to

The National Food and Drugs Authority, Uganda

by

Prof. Alexander Nii Oto Dodoo, PhD, MRPharmS, FPCPharm (Lead Consultant)

&

Ms Haggar Hilda Ampadu, BSc, MSc, CCDM

With support from

Mr. Peter Paul Mubiru

June 2013
Developing Enterprise Risk Management Framework/Facilitating Enterprise Wide Risk Assessment

A Consultancy Report Submitted to

The National Food and Drugs Authority, Uganda

by

Prof. Alexander Nii Oto Dodoo, PhD, MRPharmS, FPCPharm (Lead Consultant)

Director, WHO Collaborating Centre for Advocacy and Training in Pharmacovigilance (WHO-CC), University of Ghana Medical School, Accra Ghana and Head, Uppsala Monitoring Centre, Africa (UMC-Africa)

and

Ms Hagger Hilda Ampadu, BSc, MSc, CCDM

Director of Operations, WHO-CC and Director of Operations and Head of New Businesses, UMC-Africa

With the support of Local Consultant

Mr. Peter Paul Mubiru

June 2013
1 EXECUTIVE SUMMARY

The WHO Collaborating Centre for Advocacy and Training in Pharmacovigilance, Accra, Ghana (WHO-CC), upon request from the management of the National Drug Authority, Uganda provided support for the development of an enterprise risk management plan for the NDA. Two external consultants from the WHO-CC visited Kampala, Uganda from 11th – 14th June 2013 and, working with a local counterpart, interacted with staff and management of the NDA; undertook a situational analysis of the NDA through reviews of relevant laws, manuals and guidelines; visited the Quality Control Laboratory of the NDA, held two separate meetings with senior management and came out with the following outputs and recommendations:

1.1 OUTPUTS

The outputs of the current consultancy include the following:

1. Consultancy Report
2. Framework for developing a risk management plan
3. Tools for data collection for a risk register
4. Recommendations for follow-on actions to ensure the eventual development of a Risk Management Plan and associated risk registers

1.2 RECOMMENDATIONS

The Consultants, after having visited the NDA, interacted with staff and senior management, examined the laws regulating the NDA and upon examining the Strategic Plan Document (July 2011 – June 2016) of the NDA makes the following recommendations with respect to the development of a risk management framework for the NDA:

1.2.1 To the Government of Uganda

1. Appoint as a matter of priority the Board of Directors of the NDA in line with existing laws

2. Engage the Board of Directors of the NDA, the Secretariat of the NDA, civil society, parliament, the legislature, local and international non-governmental agencies and local and international technical agencies and regulatory authorities for input into the
proposed new legislation for the regulation of food, drugs, diagnostics, household chemicals, cosmetics, blood and biological productise etc. in Uganda

3. Provide the needed financial support and other required resources to the NDA to develop a robust risk management strategy complete with a dynamic and regularly-reviewed risk register and a risk management plan.

1.2.2 To the Management of the NDA

1. Develop a risk register for each department, unit and desk with the direct assistance of the local consultant and remote support from the external consultants from the WHO Collaborating Centre for Advocacy and Training in Pharmacovigilance, Accra, Ghana

2. Permit the following officers of the NDA to work closely with the local and external consultants in the development of the risk register: Mr. Peter Ssali Mukasa, Head of the Quality Management Department; Mrs Helen Byomire Ndagije, Head of the Drug Information Department and Mr. Baguma K. Adolf, Ag. Head Internal Unit. These personnel should receive adequate compensation for the time and effort that this important added activity requires.

3. Determine the timelines for the production of a Risk Management Plan and associated manual for the NDA and engage external and local consultants as soon as possible to ensure that the process does not stall but proceeds to a firm and effective conclusion.

4. Disseminate the process for the development of the risk register to all departments, units and desks and request cooperation from all staff and senior management

5. Engage all stakeholders for their input into the risk management strategy of the NDA

6. Work with the future NDA Board of Directors to obtain their inputs and approval of the Risk Management Strategy, Risk Management Plan and associated guidelines and manuals.
Table of Contents

1 EXECUTIVE SUMMARY..................................................................................................................3
  1.1 Outputs......................................................................................................................................3
  1.2 Recommendations ....................................................................................................................3
    1.2.1 To the Government of Uganda .......................................................................................3
    1.2.2 To the Management of the NDA ....................................................................................4

2 INTRODUCTION AND BACKGROUND............................................................................................7

3 THE CURRENT CONSULTANCY.......................................................................................................9

4 APPROACH ......................................................................................................................................10

5 FINDINGS .......................................................................................................................................11
  5.1 General – Legislation ...............................................................................................................11
  5.2 General – Governance ..........................................................................................................12
  5.3 General – Organisation of Departments, Units and Desks ..................................................12
  5.4 Drug Information Department ..............................................................................................13
  5.5 Quality Management Department .......................................................................................14
  5.6 Legal Department ..................................................................................................................14
  5.7 Quality Control Department ................................................................................................15
  5.8 Drug Assessment and Registration Department .....................................................................17
  5.9 The Food Desk ......................................................................................................................18

6 OUTPUTS .......................................................................................................................................19

7 RECOMMENDATIONS ....................................................................................................................19
  7.1 To the Government of Uganda ..............................................................................................19
  7.2 To the Management of the NDA ...........................................................................................20

8 APPENDIX 1 – BRIEF PROFILES OF THE CONSULTING TEAM ..................................................21
  8.1 Professor Alexander Dodoo, Lead Consultant .....................................................................21
  8.2 Ms Haggar Hilda Ampadu, BSc (Biol.), MSc (Project Management and International Business), CCDM, Co-consultant ........................................................................22
  8.3 Peter Paul Mubiru – Local Expert .........................................................................................22

9 APPENDIX 2 – PERSONS CONSULTED DURING THE IN-COUNTRY VISIT IN UGANDA FROM 10TH – 14TH JUNE 2013.......................................................................................24
2 INTRODUCTION AND BACKGROUND

The National Drug Authority (NDA) of Uganda is the statutory national regulatory agency of the country. It was established by an Act of Parliament, the National Drug Policy and Authority Act, (CAP. 206) which commenced on 3rd December 1993. The revised edition of the Act was in 2000. The Act and its amendments “establish a national drug policy and a National Drug Authority to ensure the availability, at all times, of essential, efficacious and cost-effective drugs to the entire population of Uganda, as a means of providing satisfactory health care and safeguarding the appropriate use of drugs”.

The NDA is also involved in the regulation of veterinary drugs to ensure sustainable animal health and production based on the principles vision espoused in the national Veterinary Drug Policy. In terms of governance, the National Drug Authority is the 20-member Board of Directors appointed by the Minister with the Executive Secretary/Registrar (ESR) acting as Secretary to the NDA. Day to day management of the NDA is however carried out by the Secretariat which is headed by the ESR and which currently is composed of nine departments namely Drug Assessment and Registration; Drug Inspectorate Services; Drug Information; Quality Control; Quality Management; Finance; Human Resource and Administration; Legal Services; and, Internal Audit. The Secretariat also has three units which report directly to the ESR. These are: Public Relations; Information Technology and Procurement. In preparation for the cabinet-approved added mandate of food regulation, the NDA has since 2010 established a Food Desk that also reports directly to the ESR.

The NDA is a body corporate with the following functions as enshrined in Section 5 of the Act:

a) Deal with the development and regulation of the pharmacies and drugs in the country
b) Approve the national list of essential drugs and supervise the revisions of the list in a manner provided by the Minister.
c) Estimate drug needs to ensure that the needs are met as economically as possible
d) Control the importation, exportation and sale of pharmaceuticals
e) Control the quality of drugs
f) Promote and control local production of essential drugs
g) Encourage research and development of herbal medicines
h) Promote rational use of drugs through appropriate professional training
i) Establish and revise professional guidelines and disseminate information to health professionals and the public
j) Provide advice and guidance to the Minister and bodies concerned with drugs on the implementation of the national drug policy; and
k) Perform any other function that is connected with the above or that may be accorded to it by law.

To ensure that these statutory functions are carried out, the NDA is involved in the following activities as outlined in its current (July 2011 – June 2016) Strategic Plan:

1. Assessment of medicines for quality, safety and efficacy
2. Registration of medicines before use on the Uganda market
3. Inspecting and licensing of all pharmaceutical outlets in Uganda
4. Inspecting foreign pharmaceutical manufacturing facilities that export their medicines to Uganda
5. Licensing medicines importers
6. Inspecting medicines at gazetted ports of entry
7. Testing of drug samples for compliance to standards
8. Screening and monitoring of drug advertisements
9. Sensitization of health workers, district officials, local council II and V officials and members of the public on all matters relating to rational medicines use, pharmacovigilance and effective drug regulation
10. Supervision of drug-related clinical trials.

The mandate of the NDA is huge and its activities are varied. In the prosecution of its mandate, it has been exposed to various types of risk and litigation. The Strategic Plan of the NDA commits itself to the establishment of an organisation that ensures that risk management is a core capability which forms an integral part of all its activities. To this end, the NDA has set in motion processes towards the development of an Enterprise Risk Management Manual to manage change and uncertainty. This forms the basis for the current consultancy and report.
3 THE CURRENT CONSULTANCY

In order to develop an Enterprise Risk Management Plan, Management of the NDA solicited technical assistance from the WHO Collaborating Centre for Advocacy and Training, Accra, Ghana with the following stated objectives:

1. To design a framework for the analysis, evaluation and monitoring of risks within the operations of the NDA. The framework is intended to support management to rank risks according to probability of occurrence and impact or consequence in case a risk materialises, and to design risk mitigation strategies.

2. To incorporate a consistent approach to risk management into the culture and strategic planning processes of the Authority, supporting the setting of priorities and making of decisions at the institutional level, as well as at the technical and administrative unit levels.

3. To develop a framework to identify potential future events that could impact key risk exposures that could have significant impact on strategy delivery and risk controls that management can take to bring the exposures within acceptable levels.

4. To help NDA apply a consistent approach to risk response and control activities to support the organisation’s governance responsibilities for innovation and responsible risk-taking, policy development, programmes and objectives.

5. To identify the risk appetite of the Authority i.e. the aggregated account of the Authority's willingness to allow management to take risks in the pursuit of its strategic objectives.

The consultancy was undertaken by two senior consultants from the WHO-CC with the assistance of a local consultant who partnered with the team to ensure that the tedious process of working with each department and unit to develop their risk registers are carried out as cost-effectively and efficiently as possible. Brief profiles of the consulting team are given in Appendix 1.
4 APPROACH

The approach utilised for the realisation of the objectives of the consultancy included the following:

1. Country visit by external consultants to Uganda from 10\textsuperscript{th} to 14\textsuperscript{th} June 2014, inclusive

2. Interactions with senior management at two separate management meetings to agree on the scope of work and for explanation by consultants of the intended working processes to management. The names and designations of officers met and interacted with are shown in Appendix 2

3. Rapid situational analysis of the NDA through desk reviews, site visits (Laboratory) and interviews with key personnel

4. Development and dissemination of the framework for developing a Risk Management Plan for the NDA

5. Data collection, specifically the population of a proposed risk register for each department and unit under the guidance of the local consultant. This activity is expected to take up to four months to complete

A PowerPoint presentation that was delivered to management to outline the processes involved in the development of the RMP as well as the follow-on actions is attached in Appendix 3.
5 FINDINGS

The situational analysis undertaken by the team of consultants identified the following based on the desk reviews of existing laws, manuals and guidelines; interactions with senior management; visit to the Quality Control Laboratory and face to face interviews with heads of departments or their appointed representatives. Departments, units and desks not specifically mentioned were not interviewed one-on-one due to time constraints though representatives of these departments attended the management meetings.

5.1 GENERAL – LEGISLATION

The laws governing the NDA – the National Drug Policy and Authority Act, (CAP. 206) is amorphous, unwieldy, complex and difficult to implement. It combines both a policy and an Act making legal enforcement difficult as the law straddles between the philosophical underpinnings of what is needed in Uganda and the prescriptive unambiguous specification of roles, actions and activities with stated penalties for non-compliance that all laws should contain. The current law also combines the regulation of premises and personnel with the regulation of products, a situation which is not in conformity with current global best practices. The separation of the regulation of pharmacy and pharmacists from the regulation of drugs, cosmetics, food, household chemicals and medical devices will only inure to the benefit of the good people of Uganda and the Ugandan government. All the stakeholders interviewed agreed that the current law had serious limitations and posed challenges in implementation. They were also aware that the government was in the process of amending the law though it was not clear the role being played by the NDA management and individual staff in the crafting of the new law. It was also not clear whether the NDA had any formal inputs into the development of the proposed new law and what stance the NDA has towards the new law. Since the legal process is long and tedious and since any law enacted by Parliament will take a long time to amend, it is strongly suggested that the NDA (Board, when in place, and Secretariat) actively and proactively gets engaged in the legislative process to ensure a sound, effective and acceptable new law consistent with international best practice and in line with contemporary developments in drug regulation including harmonization efforts in the East African Community (EAC) as well as the African Union.
5.2 GENERAL – GOVERNANCE

The absence of a Board of Directors for the NDA over the past xxx years remains a challenge. As the current law stands, it is the NDA (Board of Directors) that is responsible for all key decisions including the development of the RMP. Whilst the Secretariat has set in motion the process for the development of an Enterprise Risk Management Plan, it is unclear whether the Secretariat’s mandate permits it to introduce manuals and guidelines of critical strategic importance without the oversight and approval of the Board and the Minister. Furthermore, the absence of a Board opens up the possibility of legal challenge on the actions and activities of the secretariat both internally and externally. Thus the absence of a board in itself is a risk that needs to be managed.

5.3 GENERAL – ORGANISATION OF DEPARTMENTS, UNITS AND DESKS

The existence of departments, units and desks need clarification in terms of hierarchy and reporting lines. The fact that the heads of all units, departments and desks report directly to the ESR presupposes some level of equality. However, the status or standing of each of these need to be well stated. Furthermore, it may be prudent to consider whether merging the activities of some of these may not be more efficient and cost-effective. In terms of risks and risk management, there is the need for close alignment between the various departments, units and desks as their activities intertwine in several ways. For instance, a case relating to Public Relations may have severe implications for the Legal Department as well as for other departments like drug registration, quality control, pharmacovigilance etc. This cross-cutting issue is significantly important and needs serious consideration and resolution so as to aid in
the development of a relevant, appropriate and rigorous risk register and in the formulation of any risk management plans.

5.4 DRUG INFORMATION DEPARTMENT

The Drug Information Department also hosts the National Centre for Pharmacovigilance which is a member of the WHO Programme for International Drug Monitoring. Uganda is the 83rd member of the WHO PV programme and the presence of an active national centre is credit to the country and the management of the NDA. The Drug Information Department is responsible for carrying out pharmacovigilance, regulating clinical trials and providing information to healthcare professionals and the general public. The department does not appear to have the full human resource component that its myriad activities require.

The collection and management of safety reports from clinical trials and post-market surveys as well as GCP inspections and clinical trial regulation all require dedicated personnel. Furthermore, regulation of advertisements and monitoring of both electronic and print media for adverts not approved by the NDA is time consuming. The Drug Information Department therefore needs strengthening in human resource and the availability of technical tools. There is interface between monitoring adverts and drug promotion and Public Relations and the Drug Information Department and the Public Relations Unit will need to coordinate their activities to prevent duplication of efforts. Development of the departmental risk register must take this into consideration. Other challenges facing the department is the development of a model for regulatory decision making especially after drug or vaccine withdrawals or scares in other jurisdiction e.g. Europe, America, South Africa or the East African Community. The
department needs a Crisis Management Plan, a Communication and Advocacy Strategy and Plan as well as its Risk Register. It also needs to interface regularly and actively with all departments but especially with the Legal, Drug Assessment and Registration and Quality Control Departments.

5.5 QUALITY MANAGEMENT DEPARTMENT

The NDA has a very impressive Quality Management Department – a credit to management and the Board. The Quality Management Department has clearly laid out procedures governing all aspects of the operations of the NDA. It is current in its practices and engaging in outlook and will be the envy of any regulatory authority anywhere. However, it is not clear how departments, desks and units adhere to the properly laid out rules and regulations of the department. Adhering to quality standards is an arduous task and there is always a risk that departments, desks and units will feel controlled by the Quality Management Department. This should however not be the case and this risk should be mitigated by regular engagement of all staff and explanation of the purposes for the existence of a Quality Management system, i.e. to ensure that all activities of the NDA are carried out via processes that are clearly laid out and accepted by all. Quality management systems promote transparency, prevent arbitrariness and help in managing and mitigating risks. They also provide a strong defence for the actions and activities of the NDA in case of litigation. To ensure that the Enterprise Risk Management Plan of the NDA is coherent and not contradictory and also to make sure that the register conforms to national, international and NDA laws, manuals and guidelines, it is strongly recommended that the Quality Management Department be part of the team leading the development of the risk register. All registers prepared by departments, desks and units must be verified by the Quality Management Department for their appropriateness and conformity to NDA's established standard operating procedures.

5.6 LEGAL DEPARTMENT

The Legal Department is responsible for ensuring the NDA’s compliance with all laid down laws and procedures of the country. It is currently staffed by one lawyer. Considering the number of activities it has to undertake, it is important to strengthen this department by the recruitment of more lawyers and legal aides. The biggest challenge confronting the department is the interpretation and implementation of the current Act. The Act (Cap. 206) has several
gaps and loopholes and is not prescriptive enough in several areas. It is deficient enough in several places to aid determine litigants to flout the law and get away with it. The relationship between the NDA, the Police and the judiciary in implementing the law and prosecuting offenders requires clarity. Internally, the NDA has several guidelines, procedures and manuals some of which may appear to contradict each other. Working with the Quality Management Department should help resolve this. The NDA also needs clearly laid out procedures for their regulatory actions. For instance, seizures of products and closure of shops should occur in strict accordance to agreed procedures which have been analysed and approved by the legal department to prevent unwanted litigation. The Legal Department should be consulted on all operations of the NDA including recruitment of temporary and permanent staff; termination of appointments; disciplinary actions; health and safety at work and all other related issues. The Risk Management Plan for the NDA should bear this in mind and should emphasise regular consultation and training on legal matters as part of the overall risk mitigation strategy of the organisation.

5.7 QUALITY CONTROL DEPARTMENT

The Quality Control (QC) Department of the NDA is also the National Quality Control Laboratory. It is housed in premises outside the main headquarters building of the NDA. The staff has a staff strength (permanent and temporary) of over 20 which appears inadequate for the range of activities it undertakes. The QC Department is responsible for quality testing of medicines (using a risk based approach in which not all batches of all medicines are tested); testing of condoms and, soon, testing of biologicals. It has modern equipment (HPLC; GC etc) for its work though the absence of an appropriate electronic laboratory information management system is a serious challenge with risk implications. The QC Department has supply and servicing contracts for its reagents and equipment respectively and these mitigate risks emanating from equipment dysfunction or shortage of reagents. However, these contracts need regular review to ensure effective delivery and also to identify potential problems as exposure to single suppliers and equipment suppliers leaves the NDA vulnerable should these suppliers and engineers default.
The QC Department is establishing a microbiology lab with maximum containment levels – an activity which requires identification of risks, training of all personnel and strict observation of all standard operating procedures. The Department is currently installing appropriate ventilation equipment and its risk register should pay attention to the reliability and regular functioning of these equipment. The availability of trainers for the staff appears to be a problem and the NDA is encouraged to develop a risk mitigation strategy that has options for alternative trainers and training venues should chosen trainers not be available. The detailed risk register of the department should naturally include handling of solvents, prevention of accidents, management of accidents and incidents in the laboratory, infection control and environmental issues, in particular the disposal of reagents and the transportation, storage and management of pathogenic material. The proposed regulation of food by the NDA will call for more personnel as well as expertise for the development, assessment and implementation of food standards for all foods that are registered by the NDA (or its succeeding organisation).
5.8 DRUG ASSESSMENT AND REGISTRATION DEPARTMENT

The Drug Assessment and Registration (DAR) Department deals with the evaluation of dossiers and recommendation for registration of medicines, household chemicals, medical devices and food supplements. The Department intends to start an-all electronic registration system from 1st July 2013, a process that is fraught with several risks and challenges. Even though the development of an Enterprise Risk Management Plan for the NDA will occur after this change, it is important to begin to develop and incorporate a stringent risk register that identifies the expected risks and provides for mitigation actions and contingency plans in case of failure of mitigating actions. A key challenge facing the department is the management of variations of dossiers. The Department has been the subject of litigation by local manufacturers, an issue which is complex to grapple in view of the NDA’s express requirement that the NDA promotes local manufacturing. The Department is often dragged to court as third parties in disputes between foreign manufacturers and local agents, a situation that drains its resources. Another challenge facing the department is fast-track registration requests by government for products for public health programmes or government institutions. Naturally, this comes with the added pressure of loss of independence in assessment; hugely compressed timelines and the need for tact and dexterity in rejecting unsuitable applications. A risk management plan for the department should pay serious attention to this. The Department frequently grapples with what to do in relation to foreign regulatory decision. For instance, the discouragement of the use of cough remedies for children less than 12 years by the European Union and the USA puts the department in a fix as to whether to withdraw any such registered products in the country or to rely on Uganda’s own nascent pharmacovigilance system to determine its course of action. A risk management plan on how to handle this is important. Finally, the department should begin to focus on how to manage problems occurring due to the non-licensed use of its licensed medications. Licensed indications are not currently given to registered products but in view of the fact that safety of products depend on the indications, the DAR Department will need to give their licensed indications for products and defer to those decisions in case of litigation arising out of medical misadventure by practitioners who choose to use registered products outside their licensed indications. The reliance by government and the existing Act on cheap (or low cost) products is also a challenge that requires risk management as the NDA has to determine whether it is an economic management organisation or a regulatory body basing
its decisions on law and science rather than on economics and cost-effectiveness. Finally, ensuring the availability of controlled drugs, especially narcotics like morphine and pethidine for patients who need them requires a strong risk approach. Current laws place these products under narcotic control legislation placing health professionals and the regulator at risk of law infringement as the narcotic laws are generally targeted towards preventing trafficking rather than promoting availability and rational use of these important but highly regulated products. Manufacturers and importers rarely deal with these products and the NDA, in line with its current mandate of ensuring availability of all essential medicines, needs a risk mitigation strategy that promotes the availability, safe storage, safe distribution, safe use and safe disposal of these products. Finally, the DAR Department must develop a strategy to deal with the threats and opportunities offered by the current harmonisation initiatives of the East African Community.

5.9 THE FOOD DESK

Following the decision of the Ugandan cabinet to include food regulation into the remit of the NDA, the Food Desk was established in 2007 as a transitional arrangement. The Desk is currently involved in the long and tortuous process of working with government departments and the 1st Parliamentary Council to amend the NDA Act to include regulation of food. The amended act will cede to the NDA and its successor organisation the regulation of cosmetics, food, food supplements, blood, blood products, medical equipment and diagnostics. The NDA is certain to be confronted with huge risks in this process as organisations and companies which had hitherto remained outside the control of any clear regulatory body or agency will have to contend with rigorous regulation in the interest of public health. It is a culture change that will require an appropriate risk response to prevent derailment by some stakeholders. The NDA should fully seize the huge opportunities which come with the amendment of the law and the increase of its activities. It should develop a risk register that identifies how to exploit the opportunities provided by the proposed new law to bring in resources, strengthen its processes and deliver efficiently on the new expanded mandate. Benchmarking with other agencies e.g. the US FDA, the Ghana FDA and Nigeria’s NAFDAC is helpful and encouraged and the NDA should be applauded for already benchmarking the proposed Food Division with the processes at Tanzania’s Food and Drugs Authority (TFDA).
6 OUTPUTS

The outputs of the current consultancy include the following:

1. Consultancy Report
2. Framework for developing a risk management plan
3. Tools for data collection for the risk register
4. Recommendations for follow-on actions to ensure the eventual development of a Risk Management Manual and associated risk registers

7 RECOMMENDATIONS

The Consultants, after having visited the NDA, interacted with staff and senior management, examined the laws regulating the NDA and examining the Strategic Plan Document (July 2011 – June 2016) of the NDA makes the following recommendations in respect of the development of a risk management framework for the NDA:

7.1 TO THE GOVERNMENT OF UGANDA

1. Appoint as a matter of priority the Board of Directors of the NDA in line with existing laws

2. Engage the Board of Directors of the NDA, the Secretariat of the NDA, civil society, parliament, the legislature, local and international non-governmental agencies and local and international technical agencies and regulatory authorities for input into the proposed new legislation for the regulation of food, drugs, diagnostics, household chemicals, cosmetics, blood and biological productise etc. in Uganda

3. Provide the needed financial support and other required resources to the NDA to develop a robust risk management strategy complete with a dynamic and regularly-reviewed risk register and a risk management plan.
7.2 TO THE MANAGEMENT OF THE NDA

1. Develop a risk register for each department, unit and desk with the direct assistance of the local consultant and remote support from the external consultants from the WHO Collaborating Centre for Advocacy and Training in Pharmacovigilance, Accra, Ghana.

2. Permit the following officers of the NDA to work closely with the local and external consultants in the development of the risk register: Mr. Peter Ssali Mukasa, Head of the Quality Management Department; Mrs Helen Byomire Ndagije, Head of the Drug Information Department and Mr. Baguma K. Adolf, Ag. Head Internal Unit. These personnel should receive adequate compensation for the time and effort that this important added activity requires.

3. Determine the timelines for the production of a Risk Management Plan and associated manual for the NDA and engage external and local consultants as soon as possible to ensure that the process does not stall but proceeds to a firm and effective conclusion.

4. Disseminate the process for the development of the risk register to all departments, units and desks and request cooperation from all staff and senior management.

5. Engage all stakeholders for their input into the risk management strategy of the NDA.

6. Work with the future NDA Board of Directors to obtain their inputs and approval of the Risk Management Strategy, Risk Management Plan and associated guidelines and manuals.
8  APPENDIX 1 – BRIEF PROFILES OF THE CONSULTING TEAM

8.1  PROFESSOR ALEXANDER DODOO, LEAD CONSULTANT

Professor Alex Dodoo is an Associate Professor in Clinical Pharmacology at the University of Ghana Medical School. He is a former Board Chairman of Ghana’s national drug regulatory agency, the Food and Drugs Authority (then the Food and Drugs Board). Prof. Dodoo holds a B.Pharm degree from the Kwame Nkrumah University of Science and Technology, Kumasi, Ghana and an MSc (Biopharmacy) and a PhD degree from Kings College London, University of London. In between the MSc and PhD, he undertook a year of research in neuro-pharmacology and neuroscience at the University of Alberta, Edmonton, Canada. Prof Dodoo has extensive experience and global recognition in drug regulation, pharmacy, pharmakovigilance, immunization and clinical pharmacology. He served two terms as President of the Pharmaceutical Society of Ghana (2007-2011), one term as President of the Pharmacy Information Section of the International Pharmaceutical Federation (FIP) where he was also a member of the Board of Pharmacy Practice of FIP, the umbrella organisation for all pharmacists in the world. In 2009, Prof. Dodoo became the first African and the first non-European to be elected President of the International Society of Pharmacovigilance (ISoP), a position he held till 2012. Prof Dodoo has served on several global boards and committees including the Global Advisory Committee on Vaccine Safety, the CIOMS/WHO Working Group on Drug Development in Resource Poor Countries, the NIH Drug Safety and Monitoring Board (DSMB) for HIV/AIDS trials in Africa, the Safety Surveillance Working Group of the Bill and Melinda Gates Foundation and the Enteric and Diarrhoeal Diseases Advisory Group of the same foundation. Currently, Prof Dodoo is the Director of the WHO Collaborating Centre for Advocacy and Training in Pharmacovigilance, the Head of Uppsala Monitoring Centre Africa, a member of the Advisory Committee on the Safety of Medicinal Products of the WHO, a member of the WHO Panel on Drug Evaluation and the Chairman of the Global Vaccine Safety Initiative. Prof Dodoo is a journalist, a former editor (Ghana Review International, UK) and a current columnist for one of Ghana’s weeklies. His first book – Healthy Secrets: a layperson’s guide to health issues was published in 2010 to global acclaim and has undergone three re-prints already. Prof Dodoo is based in Accra Ghana.
8.2 **MS HAGGAR HILDA AMPADU, BSC (BIOL.), MSC (PROJECT MANAGEMENT AND INTERNATIONAL BUSINESS), CCDM, CO-CONSULTANT**

Hilda graduated from Boston University, Boston, Massachusetts, USA, in 2010 where she was awarded a Masters in Project Management and International Business degree. For the last 12 years, Hilda worked as a Senior Clinical Data Manager/Project Manager with various Pharmaceutical, Medical Device, Biotech and Contract Research Organizations in the US, Europe, Asia and Africa drug development industries. Prior to joining UMC-A, she worked with PAREXEL International where she was in charge of data operations for clients such as Bayer Healthcare, Bristol Myers Squibb, Glaxo Smith Kline and Pfizer where she gained experience in managing multi-functional budgets, complex projects, cross functional teams, virtual teams and project teams across all geographies. Hilda also holds an undergraduate degree (BSc) in Biology from the Kwame Nkrumah University Science and Technology, Kumasi, Ghana.

Hilda joined UMC-A in December 2012 as the Director Of Operations and Head Of New Business. She is responsible for the management of the contract between UMC (Sweden) and Sante-Afrique Ltd (Ghana) that led to the establishment of UMC-A. She is also responsible for the strategic directions, operations and central management of Sante-Afrique and its constituent units.

8.3 **PETER PAUL MUBIRU – LOCAL EXPERT**

Peter Paul Mubiru is a consultant in Business Advisory Services. He holds a Bachelors of Science degree from Makerere University, Uganda and is a Fellow of the Association of Chartered Certified Accountants. He is in addition, a Certified Internal Auditor and a member of the Institute of Internal Auditors. Further to that, he holds a qualification in Computer/IT audit (QICA), and a Diploma in Risk Management with majors in Business Continuity Management, and Corporate Governance. Peter is extensively experienced in supporting organisations to roll out enterprise wide risk management frameworks, and Business Continuity/Disaster recovery strategies. He worked for a great part of initial professional years as a risk manager and as a risk assurance auditor. At the time, he drove several internal audit strategies for an array of organisations that included Plan International, Save the Children, Uganda Police, Uganda Prisons, Population Services International, Africa Online. He also passionately rolled out risk
management frameworks in Plan Internationals’ country offices in Uganda, Kenya, Mozambique, and Zambia. He also designed the financial and budget management system for the European Development Fund (EU office in Uganda). Subsequent to that task, Peter Paul collaborated and extensively facilitated National Authorising office – Ministry of Finance to roll out a financial risk management system for European Union Funded projects in Uganda. In addition to his other duties, Peter lectures at the Institute of Internal Auditors and at a number of ACCA accredited colleges.
APPENDIX 2 – PERSONS CONSULTED DURING THE IN-COUNTRY VISIT IN UGANDA FROM 10TH – 14TH JUNE 2013

1. Dan N. Badebye
2. Sr. Dr. Anthonia Nakmya
3. Baguma K. Adolf
4. Mrs Helen Byomire Ndagije
5. Mr Peter Ssali Mukasa
6. Ms Diana Kabuzire
7. Ms Irene Wanyenya
8. Dr Agaba Friday
9. Mr. Gabriel Kaddu
10. Mrs Kate Kikule
11. Ms Eva Natungo
National Drug Authority, Uganda

Risk Management Plan
<DEPARTMENT NAME>

RISK MANAGEMENT PLAN

Version <1.0>

<dd/mm/yyyy>
VERSION HISTORY

Provide information on how the development and distribution of the **Risk Management Plan** up to the final point of approval was controlled and tracked. Use the table below to provide the version number, the author implementing the version, the date of the version, the name of the person approving the version, the date that particular version was approved, and a brief description of the reason for creating the revised version.

<table>
<thead>
<tr>
<th>Version #</th>
<th>Implemented By</th>
<th>Revision Date</th>
<th>Approved By</th>
<th>Approval Date</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>&lt;Author name&gt;</td>
<td>&lt;mm/dd/yy&gt;</td>
<td>&lt;name&gt;</td>
<td>&lt;mm/dd/yy&gt;</td>
<td>Initial Risk Management Plan draft</td>
</tr>
<tr>
<td>1.1</td>
<td>&lt;Author name&gt;</td>
<td>&lt;mm/dd/yy&gt;</td>
<td>&lt;name&gt;</td>
<td>&lt;mm/dd/yy&gt;</td>
<td>&lt;reason&gt;</td>
</tr>
</tbody>
</table>
Note to the Author

This document is a template outline of a Risk Management Plan document for a department in the NDA. The template includes instructions to the author, boilerplate text, and fields that should be replaced with the values specific to the department.

- Blue italicized text enclosed in square brackets ([text]) provides instructions to the document author, or describes the intent, assumptions and context for content included in this document.

- Blue italicized text enclosed in angle brackets (<text>) indicates a field that should be replaced with information specific to a particular Department.

Text and tables in black are provided as boilerplate examples of wording and formats that may be used or modified as appropriate to a specific Department. These are offered only as suggestions to assist in developing Department documents; they are not mandatory formats. Recourse should be made to the Quality Management Department in case of doubt or for clarification.

When using this template for your department document, it is recommended that you follow these steps:

1. Replace all text enclosed in angle brackets (i.e., <Department Name>) with the correct field values. These angle brackets appear in both the body of the document and in headers and footers. To customize fields in Microsoft Word (which display a gray background when selected):
   a. Select File>Properties>Summary and fill in the Title field with the Document Name and the Subject field with the Department Name.
   b. Select File>Properties>Custom and fill in the Last Modified, Status, and Version fields with the appropriate information for this document.
   c. After you click OK to close the dialog box, update the fields throughout the document with these values by selecting Edit>Select All (or Ctrl-A) and pressing F9. Or you can update an individual field by clicking on it and pressing F9. This must be done separately for Headers and Footers.

2. Modify boilerplate text as appropriate to the specific Department.

3. To add any new sections to the document, ensure that the appropriate header and body text styles are maintained. Styles used for the Section Headings are Heading 1, Heading 2 and Heading 3. Style used for boilerplate text is Body Text.

4. To update the Table of Contents, right-click and select “Update field” and choose the option “Update entire table”

5. Before submission of the first draft of this document, delete this “Notes to the Author” page and all instructions to the author, which appear throughout the document as blue italicized text enclosed in square brackets.]
# TABLE OF CONTENTS

1 INTRODUCTION ........................................................................................................................................... 31  
   1.1 Purpose Of The Risk Management Plan .............................................................................................. 31

2 RISK MANAGEMENT PROCEDURE ........................................................................................................... 31  
   2.1 Process .................................................................................................................................................. 31  
   2.2 Risk Identification .................................................................................................................................. 31  
   2.3 Risk Analysis ......................................................................................................................................... 32  
      2.3.1 Qualitative Risk Analysis .............................................................................................................. 32  
      2.3.2 Quantitative Risk Analysis ........................................................................................................... 33  
   2.4 Risk Response Planning ....................................................................................................................... 33  
   2.5 Risk Monitoring, Controlling, And Reporting ..................................................................................... 34

3 TOOLS AND PRACTICES .......................................................................................................................... 34

RISK MANAGEMENT PLAN APPROVAL ...................................................................................................... 35

APPENDIX A: REFERENCES .......................................................................................................................... 36

APPENDIX B: KEY TERMS ............................................................................................................................. 37
1 INTRODUCTION

1.1 PURPOSE OF THE RISK MANAGEMENT PLAN

[Provide the purpose of the Risk Management Plan.]

A risk is an event or condition that, if it occurs, could have a positive or negative effect on a Department's objectives. Risk Management is the process of identifying, assessing, responding to, monitoring, and reporting risks. This Risk Management Plan defines how risks associated with the <Department Name> Department will be identified, analyzed, and managed. It outlines how risk management activities will be performed, recorded, and monitored throughout the lifecycle of the Department and provides templates and practices for recording and prioritizing risks.

The Risk Management Plan is created by the Department Head or designee in consultation with the WHO Collaborating Center for Advocacy and Training In Pharmacovigilance, Accra, Ghana. It is intended to be a living document which should be monitored and updated on an ongoing basis.

The intended audience of this document is the Department team and management.

2 RISK MANAGEMENT PROCEDURE

2.1 PROCESS

[Summarize the steps necessary for responding to Department risk.]

The Department manager working with the Department team and Management will ensure that risks are actively identified, analyzed, and managed throughout the life of the Department. Risks will be identified as early as possible in the Department so as to minimize their impact. The steps for accomplishing this are outlined in the following sections. The <Department manager or other designee> will serve as the Risk Manager for this Department.

2.2 RISK IDENTIFICATION

Risk identification will involve the Department team, appropriate stakeholders, and will include an evaluation of environmental factors, organizational culture and the Department
management plan including the Department scope. Careful attention will be given to the Department deliverables, assumptions, constraints, Work Breakdown Structure, cost/effort estimates, resource plan, and other key Department documents.

A Risk Management Log/Register will be generated and updated as needed and will be stored electronically in the Department library located at <file location>.

2.3 RISK ANALYSIS

All risks identified will be assessed to identify the range of possible Department outcomes. Qualification by means of calculating the probability and rate will be used to determine which risks are the top risks to pursue and respond to and which risks can be ignored or left until later.

2.3.1 Qualitative Risk Analysis

The probability and impact of occurrence for each identified risk will be assessed by the Department manager, with input from the Department team using the following approach:

Probability

- High – Greater than <70%> probability of occurrence
- Medium – Between <30%> and <70%> probability of occurrence
- Low – Below <30%> probability of occurrence

Impact

- High – Risk that has the potential to greatly impact Department cost, Department schedule or performance
- Medium – Risk that has the potential to slightly impact Department cost, Department schedule or performance
- Low – Risk that has relatively little impact on cost, schedule or performance
Risks that fall within the RED and YELLOW zones will have risk response planning which may include both risk mitigation and a risk contingency plan.

2.3.2 Quantitative Risk Analysis
Analysis of risk events that have been prioritized using the qualitative risk analysis process and their affect on Department activities will be estimated, a numerical rating applied to each risk based on this analysis, and then documented in this section of the risk management plan.

2.4 RISK RESPONSE PLANNING
Each major risk (those falling in the Red & Yellow zones) will be assigned to a Department team member for monitoring purposes to ensure that the risk will not “fall through the cracks”.

For each major risk, one of the following approaches will be selected to address it:

- **Avoid** – eliminate the threat by eliminating the cause
- **Mitigate** – Identify ways to reduce the probability or the impact of the risk
- **Accept** – Nothing will be done
- **Transfer** – Make another party responsible for the risk (buy insurance, outsourcing, etc.)

For each risk that will be mitigated, the Department team will identify ways to prevent the risk from occurring or reduce its impact or probability of occurring. This may include prototyping, adding tasks to the Department schedule, adding resources, etc.

For each major risk that is to be mitigated or that is accepted, a course of action will be outlined for the event that the risk does materialize in order to minimize its impact.
2.5 RISK MONITORING, CONTROLLING, AND REPORTING

The level of risk on a Department will be tracked, monitored and reported throughout the Department lifecycle.

A “Top 10 Risk List” will be maintained by the Department team and will be reported as a component of the Department status reporting process for this Department.

All Department change requests will be analyzed for their possible impact to the Department risks.

Management will be notified of important changes to risk status.

3 TOOLS AND PRACTICES

A Risk Register will be maintained by the Department manager and will be reviewed as a standing agenda item for Department team meetings. The Risk Log is attached in Appendix. See screen shot of risk register below.
3.1 RISK MANAGEMENT PLAN APPROVAL

The undersigned acknowledge they have reviewed the **Risk Management Plan** for the `<Department Name>` Department. Changes to this Risk Management Plan will be coordinated with and approved by the undersigned or their designated representatives.

[List the individuals whose signatures are desired. Examples of such individuals are Department Manager. Add additional lines for signature as necessary. Although signatures are desired, they are not always required to move forward with the practices outlined within this document.]

<table>
<thead>
<tr>
<th>Signature:</th>
<th>Date:</th>
</tr>
</thead>
<tbody>
<tr>
<td>___________</td>
<td>______</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Print Name:</th>
</tr>
</thead>
<tbody>
<tr>
<td>___________</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Title:</th>
</tr>
</thead>
<tbody>
<tr>
<td>___________</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Role:</th>
</tr>
</thead>
<tbody>
<tr>
<td>___________</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signature:</th>
<th>Date:</th>
</tr>
</thead>
<tbody>
<tr>
<td>___________</td>
<td>______</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Print Name:</th>
</tr>
</thead>
<tbody>
<tr>
<td>___________</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Title:</th>
</tr>
</thead>
<tbody>
<tr>
<td>___________</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Role:</th>
</tr>
</thead>
<tbody>
<tr>
<td>___________</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signature:</th>
<th>Date:</th>
</tr>
</thead>
<tbody>
<tr>
<td>___________</td>
<td>______</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Print Name:</th>
</tr>
</thead>
<tbody>
<tr>
<td>___________</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Title:</th>
</tr>
</thead>
<tbody>
<tr>
<td>___________</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Role:</th>
</tr>
</thead>
<tbody>
<tr>
<td>___________</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signature:</th>
<th>Date:</th>
</tr>
</thead>
<tbody>
<tr>
<td>___________</td>
<td>______</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Print Name:</th>
</tr>
</thead>
<tbody>
<tr>
<td>___________</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Title:</th>
</tr>
</thead>
<tbody>
<tr>
<td>___________</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Role:</th>
</tr>
</thead>
<tbody>
<tr>
<td>___________</td>
</tr>
</tbody>
</table>
## APPENDIX A: REFERENCES

[Insert the name, version number, description, and physical location of any documents referenced in this document. Add rows to the table as necessary.]

The following table summarizes the documents referenced in this document.

<table>
<thead>
<tr>
<th>Document Name and Version</th>
<th>Description</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Document Name and Version Number&gt;</td>
<td>[Provide description of the document]</td>
<td>&lt;URL or Network path where document is located&gt;</td>
</tr>
</tbody>
</table>
5  APPENDIX B: KEY TERMS

[Insert terms and definitions used in this document. Add rows to the table as necessary. Follow the link below to for definitions of Department management terms and acronyms used in this and other documents.]

The following table provides definitions for terms relevant to the Risk Management Plan, for example NDA.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>NDA</td>
<td>National Drug Authority</td>
</tr>
<tr>
<td>[Insert Term]</td>
<td>[Provide definition of the term used in this document.]</td>
</tr>
<tr>
<td>[Insert Term]</td>
<td>[Provide definition of the term used in this document.]</td>
</tr>
</tbody>
</table>